City and Regional Planning
California Polytechnic State University, San Luis Obispo

Land Use Survey Manual for CRP 552
# Table of Contents

I. Introduction ........................................................................................................... 4

II. Required software & hardware/data files ............................................................... 5

III. Survey Instrument Preparation ............................................................................ 6

   1. Configure the iPads .......................................................................................... 6

IV. Parcel database preparation ................................................................................. 7

   2. Convert the parcel shapefile into a geodatabase. ............................................ 7

   3. Configure the Geodatabase in Microsoft Access .............................................. 8

   4. Convert the Access Geodatabase to the proprietary HanDBase format ....... 9

   5. Perform additional Configuration in HanDBase Desktop – Inputting List
      Values. ................................................................................................................ 10

   6. Downloading the database to the iPads ........................................................... 11

   7. OPTIONAL – Alternate Method for creating list values ............................... 12

   8. OPTIONAL – Form Creation .......................................................................... 13

   9. OPTIONAL – Editing and Refining Forms ......................................................... 14

V. Data Collection and Management ......................................................................... 19

   10. Data Collection ................................................................................................. 19

      10.1 Performing a search ................................................................................... 19

      10.2 Navigating the default view ..................................................................... 20

      10.3 Entering data ............................................................................................. 21

   11. Merging data from the iPads ......................................................................... 23

   12. Extracting Data from the iPads ..................................................................... 25

VI. Importing to ArcGIS and mapping ...................................................................... 26

      13.1 Importing from CSV format to Access ..................................................... 26

      13.2 Updating the Geodatabase with the imported data ............................... 27

      14. Assigning Values to the General Land Use Fields ................................... 29

      15. Representing Parcels in ArcMap ................................................................. 32

VII. Final Considerations ............................................................................................ 33

     Quality Assurance/Control .............................................................................. 33
Working with the data ........................................................................................................34
Generating new data ........................................................................................................34
Appendix A - List of Attributes and Corresponding Values .................................................35
Appendix B - Form Creation Values ..................................................................................36
  Table 1. Parcel Form Specification ..................................................................................36
  Table 2. Structure 1 Details Form Specification ...............................................................37
  Table 3. Structure 2 Details Form Specification ...............................................................38
  Table 4. Structure 3 Details Form Specification ...............................................................39
Appendix C - Survey Map Creation ...................................................................................40
  1. Create an Grid Index for the Survey Maps ................................................................40
  2. Setup Data Driven pages using the Index Layer ..........................................................41
Appendix D – Importing new parcel attributes into an Existing Database .......................44
Appendix E – Importing data entry forms from an older land use database into a new land use database ..............................................................47
I. Introduction

This manual outlines a procedure for the collection of land use data for the General Plan Studio course. This method is beneficial for a couple of reasons, including:

- Data is collected electronically. The method eliminates the need to carry paper survey forms, which makes the actual surveying process easier. Additionally, the collected data will already be in an electronic format and almost ready for use with ArcGIS software.

- Data is collected consistently. The use of electronic survey instruments allows for the definition of values for numerous attributes to be collected at the level of the parcel. When multiple survey groups are necessary to expedite the data collection phase, this method assures that all groups are inputting the same data for observations made in the field.

The following is a list of subsequent sections of this manual, and a description of the content of each section:

**Section II** lists the required software, hardware, and data files needed for the survey.

**Section III** covers how to prepare the survey instruments with the necessary email accounts and software installation.

**Section IV** describes how to prepare the parcel database using ArcGIS, Microsoft Access, and HandDBase software. This section also covers how to download the database to the survey instruments, and optional steps of form creation and editing.

**Section V** details how to collect the data in field, how to merge data collected on different survey instruments, and extraction of the data from the survey instruments.

**Section VI** covers how to import extracted data into the Access and ArcGIS, and provides direction for final data edits and representation of the land use data in ArcMap.

**Section VII** provides final considerations for working with the data, including Quality Assurance/Control, and the generation of new data that may be useful in the studio course.
II. Required software & hardware/data files
   a. Microsoft Access
   b. ArcGIS 10
   c. HanDBase for iPad
   d. HanDBase Data Exchange for Microsoft Access
   e. HanDBase Desktop
   f. Parcel shapefile for the jurisdiction saved on the desktop computer. This can be acquired from the city or the county.
   g. A local wifi network.
III. Survey Instrument Preparation

This section details the preparation of the survey instrument. Instructions are provided for the initial configuration of the iPad with the required software.

1. Configure the iPads

On the iPads:

   a. Select Settings > Store > Sign In > Use Existing Apple ID.

   b. Enter the following login details:

      email: calpoly.crp552@gmail.com
      password: GeneralPlan5

   c. Select Mail, Contacts, Calendars > Add Account > Gmail.

   d. Enter the following login details for the gmail account:

      Address: calpoly.crp552@gmail.com
      Password: GeneralPlan

   e. Select Next and wait for the verification process to complete.

   f. Select Save.

   g. Return to the iPad home screen and access the App Store.

   h. In the App Store, search for 'Handbase for ipad'.

   i. Select Install.

   j. Repeat steps 1.a. – 1.i. on any additional iPads for use in the survey process.

The iPad should exit the App Store, return to the Home Screen and begin downloading the software.
IV. Parcel database preparation

The following sections detail how to prepare the parcel database on a PC using ArcGIS 10 software, Microsoft Access, HanDBase Data Exchange, and HanDBase Desktop.

2. Convert the parcel shapefile into a geodatabase.

On the PC:

a. Open ArcCatalog
b. In ArcCatalog, use the Connect to Folder button to create a connection to the folder which contains the parcel shapefile (Figure 1).
c. Clip the parcel shapefile with a shapefile for the jurisdictional boundary, if necessary.¹
d. Compute the Parcel Acreage.²
   i. Open ArcMap and load the parcel shapefile into a blank workspace.
   ii. Access the attribute table for the shapefile.
   iii. Add a new field to the table. Name the field ‘Acres’ and select ‘Double’ for the Type. Use the Calculate Geometry function in the attribute table to compute the parcel acreage.
e. Add a unique identifier field.
   While the attribute table will already display a unique identifier named OBJECTID for every record, it is necessary to create an additional unique identifier roughly based on the sequential order of the parcel APNs. Doing so will facilitate more efficient data collection in the field.

¹ If the only available parcel shapefile is one which contains parcels outside of the jurisdiction to be surveyed (i.e., a countywide parcel shapefile), it is advisable that the shapefile be clipped with the boundary of the jurisdiction BEFORE it is exported into a Geodatabase. This will ensure that the database is as small as possible and improve performance while working with the data in the future. Use ArcCatalog’s Clip tool in ArcToolbox under Analysis Tools > Extract > Clip.

² Parcel Acreage should be computed in ArcMap even if the parcel shapefile includes acreage information. This is primarily because parcels which are bisected by the jurisdictional boarder will have a smaller size once the clip is performed.
i. With the attribute table for the parcels accessed, right click on the header for the APN column, and select "Sort Ascending.

ii. Access the Sort tool in ArcToolBox (Data Management Tools > General > Sort). Select your parcel shapefile for the Input Dataset, and specify an output dataset and location. Choose the APN attribute field, and verify that it appears in the Sort Fields window with an Ascending Sort Method.

iii. Click OK. ArcMap will create a new shapefile with a unique identifier named "OBJECTID" that will be number each parcel, starting from 1, in the order of the APN numbers.

f. In ArcCatalog, right click on the folder which will store the Land Use Database and select New > Personal Geodatabase.

g. Right click on the shapefile and select Export > To Geodatabase (single). Specify the Output Location as the Geodatabase which was created in the previous step. Specify a unique name for the resulting Feature Class in the Output Feature Class field. Click OK. Verify that the Feature Class has been created in the Geodatabase (Figure 2).

3. Configure the Geodatabase in Microsoft Access

   NOTE: If you wish to import the parcel attributes for a new survey into a preexisting existing and configured database (allowing you to skip steps 3, 4, and 5, see Appendix D and then proceed to step 6. Otherwise, if you are making a database from scratch, proceed with this step.

   a. Open Microsoft Access.

   b. Select Open from the Start Button menu in the top left corner.

   c. Open the Geodatabase which was created in step 2f.

   d. In the Navigation Pane on the left, locate the Table for the Feature Class which was created in step 2f. It should have the same name as the feature class, followed by the text ":Table".
Verify that the table opens by double clicking it in the Navigation Pane.

e. Right click the table name in the Navigation Pane and select *Design View*.

In the design view, you will populate the table with all of the attributes that are to be collected in the field. Generally, the only attribute types you will add will be TEXT, NUMBER and DATE. Refer to **APPENDIX A** for a detailed list of specific attributes.

f. Enter all appropriate attribute names as referenced in **APPENDIX A – List of Attributes**.

g. Return to the Table View to save the design changes to the table. Close Microsoft Access.

4. **Convert the Access Geodatabase to the proprietary HanDBase format**

   a. Open **HanDBase Data Exchange for Microsoft Access**.

   b. Select ‘Convert Access to HanDBase Database’ (Figure 3).

   c. Click the ‘Browse’ button next to the field labeled ‘Enter an MSAccess (.mdb) database to import from:’ Select the Access/Geodatabase from steps 3 (Figure 4).

   d. In the drop down window labeled ‘Select the table to import data from’, select the table with the previously added attribute fields from step 3 (Figure 4).

   e. Click the ‘Browse’ button next to the field labeled ‘Enter a destination HanDBase database:’ Choose a location and name for the new database (Figure 4).

   f. Select ‘Import Selected Columns’ and click the *Select Columns* button. Select all of the columns which were created in step 3f (refer to Appendix A). Also select the OBJECTID, Acres, and APN (if available) columns. Click *OK* (Figure 4).

   g. Click ‘Import’ to create the HanDBase database (.PDB format).
5. Perform additional Configuration in HanDBase Desktop – Inputting List Values.³

a. Open HanDBase Desktop.
b. Open the .PDB database which was created in step 4g.
c. Click the heading of the column labeled ‘SpcPri_LU’ (Specific Primary Land Use) and select Field Properties.
d. Click the Edit Popups button.
e. Click the New button in the window that appears.
f. Enter a General Land Use Category value. In Figure 5, ‘Residential’ is entered. Click OK.
g. The New button should remain highlighted. Press Enter on the keyboard to quickly access the Edit Popup window again.
h. Enter a Residential Specific Land Use Category (i.e., Single family detached).
i. Repeat steps 5f – 5h to input remaining general and specific Residential Land Use Categories.
j. On the Edit Popup List, use the up and down arrow buttons to reorder specific land use categories under their respective general land use categories as illustrated in Figure 6, if necessary.
k. Highlight each specific land use category and click the right arrow button to shift the selected category to the right. This establishes a ‘parent/child’ relationship between the general and specific land use categories. Each specific category falls under a general category (Figure 6).

l. Click the OK button to close the ‘Edit Popup List’. Click it once more to close the ‘Edit Field’ window for the ‘SpcPri_LU’ column.
m. Repeat Steps 5c – 5l for the ‘SpcSec_LU’ and ‘SpcTer_LU’ columns. These columns should have the same values and Parent/Child relationships as the SpcPri_LU field.

³ An alternate method of accomplishing this step is provided in Step 7, which begins to cover database preparation via the HanDBase iPad application. However, this method may be more time consuming given the iPad’s touch interface.
n. Perform similar operations on the fields highlighted with an asterisk in table 1, Appendix A. Note the none of the other fields with listed values will utilize Parent/Child relationships, making step 5k unnecessary for the subsequent list value preparation.

o. Save and close the database.

6. Downloading the database to the iPads

With the iPad connected to a local wireless network:

a. Download the database to the iPads via email.
   i. Email the .PDB HanDBase database as an attachment to calpoly.erp552@gmail.com.
   ii. Access the email on each of the iPads and open the attachment in HanDBase.

Alternatively, you can use HanDBase for iPads built-in Desktop Connection mode to transfer the database to the iPads, although this method may be more time consuming. With the iPad(s) connected to the same wireless network as the desktop computer:

b. Upload the database to the iPad via Desktop Connect
   i. Open HanDBase on the iPad.
   ii. Press the HanDBase button at the top left of the application to access the ‘Databases’ panel if it is not open.
   iii. Press the Connect icon at the bottom right of the ‘Databases’ panel.
   iv. A window displaying an ip address should appear. On the desktop computer, open a web browser and enter this ip address into the address bar to establish a connection between the desktop and the iPad.
   v. A server screen for the iPad should appear within the browser window (Figure 7). Click the Choose File button under the ‘Upload File (Database, Form, Image)’ window to the right.
vi. Locate the .PDB HanDBase database and select it for uploading. Press the *Add File* button.

vii. Verify that the database has downloaded and can be opened.

### 7. OPTIONAL – Alternate Method for creating list values

This section specifies an alternate method of inputting the list values using the HanDBase application on the iPad itself, rather than using the HanDBase desktop application if it is otherwise unavailable. You may skip this section if the list values were previously created as per section five, however, this section may be useful as a guide in case the attribute list values need to be adjusted in the field.

On one of the iPads with the database installed from Section 6:

1. Open HanDBase.
2. Access the database properties by pressing the *Databases* button in the top left corner. Press the *Manage* button, select the parcel database, then select *Properties* (Figure 8).
3. On the *Database Properties* window which appears, select *Fields*.
4. In this example, select the ‘SpcPri_LU’ when the list of fields appears.
5. On the *Edit Field* window, select *Edit Popup List*.
6. Use the *New* button at the bottom left of the *Edit* window to input General and Specific land use values with the iPad keyboard. Minimize the keyboard and press the *Save* button in the top right corner of the *Edit* window to save the new value to the popup list for the attribute.
7. To establish Parent/Child relationships between the General and Specific land use values, select the appropriate Specific Land Use value and press the *Child* button which appears at the bottom of the *Edit List* window to make the selected value a child of the General Land Use value which it follows on the list. If the values need to be rearranged, press, hold and drag the three line icon on the right side of the value to drag it to the desired location within the list (Figure 9).
h. Once all of the values have been entered for the attribute, press the Back button at the top left on the Edit Popup window to return to the Edit Field window.

i. Press the Save button at the top right of the Edit Field window to return to the Field Selection window.

j. Repeat steps 7d-7i for other fields which will utilize list selections as specified in table 1 in Appendix A.

k. Press the Back button to return to the Database Properties window. Press Back again to close the window.

l. Proceed back to the database management view from step 7b (Figure 8), and select ‘Email’.

m. An email composition window should appear with the database already attached. Send the email with the attached database to calpoly.crp552@gmail.com. This will send a copy of the database, with the attribute lists you have created in this section to the other iPads.

n. Access the email from the other iPads and install the database as previously done in step 6.a.ii.

8. OPTIONAL – Form Creation

The following two steps outline the procedure for creating custom forms for use with the parcel database which has been imported and configured in the previous sections. These sections are optional as it is possible to edit the individual parcel records using the default input interface that HanDBase provides. However, creating custom forms may allow for easier, faster data gathering in the field.

NOTE: The most recent version of HanDBase for iPad allows for the importation of forms from one database to another. This means that if you are using an iPad with a previously used land use database with custom forms, you may import those forms into the new land use database rather than creating forms from scratch as outline in steps 8 and 9. See Appendix E for a guide to transfer the forms from an older database to a new database. Otherwise, proceed with this step if you wish to create a data entry forms from scratch.
On the iPad with the land use database:

a. Load HandDBase and open the parcel database.

b. Press the Tools button in the lower right hand corner.

c. Select Database Properties.

d. Select Forms on the Database Properties window.

e. Click the Restore Purchases button on the Forms Info window

f. Enter the password for the AppleID [GeneralPlan5]

g. When the application displays the Database Properties window, select Forms once more.

h. Press the New button in the lower left corner of the blank Forms List.

i. Select Add Blank Form.

j. On the Form Details window, enter ‘Land Use’ on the ‘Form Name’ field.

k. Under Show Which Buttons, uncheck Delete Button and New Button.

l. Select Save in the upper right hand corner of the Form Details window.

m. Repeat steps 8.i - 8.l once more to create a form for surveying a structure on each parcel, entering ‘Structure 1 details’ for the Form Name (NOTE: Do not create forms for the second and third structures at this point. It would be more efficient to finish the design of the ‘Structure 1 details’ form and then copy it to create the other two structure detail forms.

9. OPTIONAL – Editing and Refining Forms

References are made to Appendix B in this step for specifics regarding the form creation.

a. On the Forms List, select the Land Use form.

b. Select Edit.

c. Press the New button in the lower left corner of the blank form.
HanDBase provides a number of ‘Controls’ for creating customized forms. For our purposes, the following controls will be used to create forms for the land use survey. (Figure 10)

**Text Box {1}** - This control can be used to display the value which is currently in a referenced field/attribute for a selected parcel. You can also enter values by clicking on Text Box and then using the software keyboard which appears.

**Labels {2}** – This control functions as a customizable label for the form you are creating. These can be used in conjunction with Text Boxes to clearly indicate what type of data should be entered in the text box.

**List Box {3}** - This control is a window which lists all of the possible values for its referenced field/attribute. For fields/attributes with predetermined categories (i.e., Specific Land Use Fields, Sidewalk Condition, Street Suffix), this field is useful because the values will be readily displayed when the surveyor opens the form for the parcel. The surveyor only needs to touch the value to select it, rather than input it manually via the software keyboard.

**Popup {4}** - This control is similar in function to the List Box control; however, rather than displaying applicable values in a list, the values appear in a popup window when the surveyor presses the control.

**Tabs {5}** – This control is used to navigate between the different forms for the selected parcel. They can also be configured to indicate which form is currently active when surveying.

**Buttons {6}** – This control is used to activate a specified action. For the land use survey, this control will only be used to select the date on which the selected parcel is being surveyed.

Careful placement and design of the functions of the controls will ensure that the surveyor is able to input data in a time efficient manner and accurate manner. Generally speaking, individual controls, such as the Text Box, are useless without supporting controls, such as labels, which clearly communicate to the surveyor the type of data that should be entered (Tabs are an exception to this). Figures 11 and 12 illustrate the ideal control ‘pairings’ to ensure efficient and accurate data entry.

**Label & Text Box pairing {1}** – The label is placed next to the text box control to clearly indicate the type of data that should be entered into the
text box. Here, the surveyor will tap the text box, and will input the required information via the iPad’s software keyboard. Each text box points to a single specified attribute in the parcel database so that when the surveyor enters information into the text box, the specified attribute is updated for the currently selected record/parcel.

Note that for the Land Use form, the Map ID, APN, and Acreage fields should not be editable by the surveyor. This text boxes should be placed with the capability to only display the current values for the selected record/parcel. There should be no need for the surveyor to edit these values in the field.

The following attributes will utilize this control pairing:

**Land Use Form**

Map ID, APN, Acreage, Street address (number), Street name, Parcel Notes

**Structure Details Forms**

Structure notes, Number of stories, Number of units, Number of vacant units, Business name(s)

**Label, Text Box & Popup pairing {2}** – The label is placed next to the text box control to clearly indicate the type of data that should be entered. The Popup control is placed nearby. Here, the surveyor will tap the arrow on the Popup control to activate the Popup list, which will display the possible values for selection. The surveyor will select the value from the Popup window, and the value will be displayed in the textbox, providing confirmation that the correct value was selected.

The Street Suffix attribute on the Land Use form is the only attribute which makes use of this combination.

**Label, Text Box & Listbox pairing {3}** - The label is placed next to the text box control to clearly indicate the type of data that should be entered. The List Box control is placed nearby. Here, the List Box automatically displays the selectable values. The surveyor will select the appropriate value from the List Box, and the value will be displayed in the textbox, providing confirmation that the correct value was selected.

![Figure 12]
The following attributes will utilize this control pairing:

**Land Use Form**
Sidewalk Condition, Specific Primary Land Use, Specific Secondary Land Use, Specific Tertiary Land Use

**Structure details Forms**
Condition of Building, Presence of Unit Conversion, Paved access to street, Sidewalk Access

**Label, Label & Button pairing {4}** – This pairing allows the surveyor to specify a date during which the parcel is surveyed. One label is placed next to a button to clearly indicate the function of the button. A second label is placed nearby. This second label actually functions similarly to the text box to provide confirmation to the user that the correct date was entered (The date field will only display via a label – Text Boxes do not work). The button activates the date selection function.

The Date attribute on the Land Use form is the only attribute which makes use of this combination.

*d.* Select the appropriate controls to create the Land Use form as illustrated in Figure 11. When a control is chosen from the ‘Add a Control’ window, it will appear on the form. Use the *Move* and *Size* buttons at the bottom of the screen to change the location and size of the chosen control. Use the *Select* button to interactively select a control. Use these buttons in combination with each other to place each form control as per Figure 11. Once a control is placed and appropriately resized…

*e.* Press the *Settings* button at the bottom of the screen to access the selected control’s individual attributes. A window will appear which will allow you to adjust various parameters for the selected control. See Appendix B for a complete guide to changing the attributes of each control.

*f.* Once the appropriate parameters are set for all controls on the Land Use form, go back to the forms list and edit the ‘Structure 1 details’ form. Repeat steps 9c-9e, using Appendix B as a guide for the placement and configuration of the controls on the
‘Structure 1 Details’ form, so that it is similar in appearance to Figure 12.

g. When the ‘Structure 1 details’ form is complete, return to the Forms List Window.

h. Select the ‘Structure 1 details’ form, then select copy.

i. In the Form Details window that appears, enter ‘Structure 2 Details’ under Form Name. Uncheck the Delete Button and New Button selections under Show Which Buttons.

j. Edit the ‘Structure 2 Details’ form as per the specifications indicated on the Structure 2 Details tab in Appendix B. NOTE: Because this is a copy of the first Structure Details form which was previously complete, you will not need to add or remove any form elements. Any editing for this form will be for functionality of the elements, so that any data input for a second structure will be input into the appropriate columns for the second structure rather than overwriting the data for the first structure. Also note that the functionality for the tabs will need to be changes slightly. Again, refer to the Structure 2 details tab/table in Appendix B.

k. Repeat steps 9g – 9j for the ‘Structure 3 details’ form.

l. When finished, press the Back button to return to the database. Access an individual record in the database by touching it, and ensure that the forms appear and function as designed.

m. Email the completed database, with the forms attached, to the calpoly.crp552@gmail.com. Download the database and form attachments for the other survey instruments.
V. Data Collection and Management

The following sections provide instructions regarding data collection in the field, consolidating and redistributing collected data, and extracting your data from the iPads.

10. Data Collection

This section outlines considerations for effectively collecting data in the field by providing instructions for efficient use of the HanDBase application. This section assumes that the survey you are using is designed as per the earlier specifications provided in this manual and in the Appendices. For additional information regarding functionality of the HanDBase application, please refer to the HanDBase User’s Manual.

When the application is first started, a screen similar to that in Figure 13 will appear. To access the Land Use Database for surveying, simply press the Databases button in the top right screen to open the panel on the left which displays all installed databases. Locate the Land Use database you are planning to use, and press its name on the panel.

When the database opens, a screen similar to that in Figure 14 (next page), will appear. This is the default view of the HandDBase database that you have created. The default view can be used to quickly navigate records in the database, which can be sorted by a specified field. The user can also instantly locate a record by using the search bar located at the top of the view.

10.1 Performing a search

In order to run a search with the search bar at the top of the Default View, you must first specify an attribute to be search:

a. Press the Tools icon in the lower right corner.

b. Select Database Properties > Change Field Order.

c. Notice the "Quick Search Field" option. Click the field to choose a particular attribute to assign to the quick search.
d. Press the Save button to the Database Properties window, and press the Back button to return to the default view.

e. Press the Quick Search field to bring up the software keyboard. You can then enter a value to search for on the previously selected attribute.

10.2 Navigating the default view

To browse records in the default view, swipe your finger up or down on the table of records. This can be useful if the record you wish to locate is near your current view of records. For large land-use databases comprised of thousands of records, it may be preferable to use the quick search field to instantly navigate to the record you wish to view, or to get to the area of the table that you wish to examine in more detail.

For instance, using the OBJECTID field as a reference, if you know that you want to examine records 9000-9020, simply set the Quick Search Field to the OBJECTID field (as per section 10.1), then touch the Quick Search Field and input "9000" in the software keyboard. As you input this search value, the default table view will change to display only the records that satisfy your search. Because the OBJECT ID field should have a unique value for each record, inputting "9000" will display any records which contain a text string of "9000" (e.g., 9000, 59000, 69000) ("900" will not be displayed because the search includes three zeros rather than two.)

When the table displays the applicable records as per your search, select the record by touching its row. If you've set up forms for your database, the first form should appear for the record you've selected. From here, press the CANCEL button in the top right corner to return to the Table View. Now press the "x" in the Quick Search field. This will display all of the records in the area of the particular record for which you previously ran the search (in this case, records sequentially following record "9000" should be in the displayed for easy viewing and navigation.

Additionally, you can swipe the Attribute Header Row left or right to view different attributes that may be outside of the current default view. You can also touch the an attribute in the Header Row to bring up a popup window which will allow you to sort your current view by a particular attribute. Most of the time for the purposes of the Land Use survey, adjacent parcels in the field will be sequentially ordered by their
APN number. Recall that in step 2e, we created a unique identifier that roughly corresponded to the APNs sorted in ascending order. Thus, when you are in the field with the survey instrument, you should sort the land use database by the OBJECT ID field in ascending order if it is not already sorted as such. Doing so will allow you to quickly access records for adjacent parcels in a sequential fashion. Simply touch the header for the OBJECTID field, then select "Sort Forward" to sort the records in ascending order.

Now, when you access an individual record to display its data entry form, you can press the NEXT button at the bottom of the screen to proceed to the next ordered parcel form without having to go back to the default Table View.

**10.3 Entering data**

To enter data, select the record that corresponds to the parcel that is being surveyed to access the data entry form for the parcel. Assuming that you have created custom forms for the Land Use survey as outlined in step 9 and in Appendix B the Address and Land Use form should appear (Figure 15). The top of the form should display the OBJECT ID field (labeled MAP ID), the APN for the parcel, and the parcel's acreage. These field should not be editable (i.e., if the text boxes for these fields are touched, the software keyboard should not appear.

- **a.** Touch the text boxes for the Street Address (number) and Street Name fields to enter this information for the parcel being surveyed with the software keyboard. Verify that the inputted values appears in the corresponding text boxes.
- **b.** Touch the dropdown control for the Street Suffix field to access the list of street suffixes. Select the appropriate one for the parcel being surveyed. Verify that the selected value appears in the Street Suffix text box.
- **c.** Touch the G, F, or B values in the Sidewalk Condition list box control to input the appropriate value for the condition of the sidewalk in front of the parcel. Verify that the selected value appears in the Sidewalk Condition text box.
- **d.** Select a Primary Land Use category by touching the appropriate general land use designation, and then the specific land use designation that most accurately reflects the parcel. For instance, Residential is chose, the list box will present the different types...
of residential categories for selection. Verify that the selected value appears in the Primary Land Use text box.

NOTE: If the parcel is a mixed use parcel, choose the appropriate type of mixed use category for the primary land use parcel. Then enter the predominant or ground floor land use in the Secondary Land Use field. Enter the other land use in the Tertiary Land Use field.

e. Enter any notes for the parcel by touching the Parcel Notes text box.

f. Press the Structure 1 details tab at the top of the Address and Land Use form for switch to the Structure 1 Details form (Figure 16).

g. Enter any notes for the structure by touching the Structure 1 Notes text box.

h. Touch the text boxes for the Number of Stories, Number of Units, Number of Vacant Units, and Business Name fields to enter the appropriate information for the structure being surveyed, if applicable, with the software keyboard. Verify that the inputted values appear in the corresponding text boxes.

i. Touch the appropriate values in the list box controls for the Condition of Building, Presence of Unit Conversion, Paved Access to Street, and Sidewalk Access fields to enter data for the structure. Verify that the selected values appear in the text boxes for these data.

NOTE: If the parcel does not have a structure (the Land Use is Vacant), the Paved Access to Street and Sidewalk Access fields should still be entered for the parcel. For instance, is the sidewalk in front of the parcel has a curb cut which would allow vehicles to access the parcel from the street, then "Y" could be selected for the value. For the Sidewalk access field, select "Y" if the parcel is abutting the sidewalk. If vacant parcel being surveyed is on the far side of another vacant parcel (i.e., not adjacent to the sidewalk) then "N" should be selected for these values, unless there is a paved driveway or walkway leading to the interior parcel.
j. If the parcel as a second structure, touch the **Structure 2 Details** tab to access the **Structure 2 Details** form, and repeat steps 10.3g - 10.3i for the second structure.

k. If the parcel as a third structure, touch the **Structure 3 Details** tab to access the **Structure 3 Details** form, and repeat steps 10.3g - 10.3i for the third structure.

l. Verify that the data is correct for all the forms. Press the **NEXT** button at the bottom of the screen to proceed to the record for the next parcel to be surveyed. Alternatively, you can press the **OK** button in the top right corner to return to the Default Table View if you know that the **NEXT** button with not proceed to the subsequent parcel to be surveyed (Most of the time this will not be the case, especially if you are surveying adjacent residential parcels). When you press either the **NEXT** or **OK** buttons, the information that you have input for the parcel will be saved.

m. Repeat steps 10.3a-10.3l for the next parcel.

**NOTE:** If you pressed **NEXT** in step 10.3l to access the subsequent record, **ALWAYS** ensure that the database has proceeded to the appropriate parcel by checking the **MAP ID** field against your survey map. **ALWAYS DO THIS BEFORE YOU BEGIN TO INPUT DATA FOR THE NEW PARCEL! OTHERWISE, RETURN TO THE TABLE VIEW TO SELECT THE APPROPRIATE PARCEL!**

For detailed instructions regarding Land Use Survey methods, refer to Appendix D.

**11. Merging data from the iPads**

Because the Land Use Survey is likely to be conducted by multiple pairs of surveyors (one person to enter data on the iPad, and another person to assess the parcel and handle the survey maps), it will be necessary to merge the data from the different iPads at the end of an individual survey day. This will help assure that in the case of subsequent survey days, duplicate data will not be collected. By merging the collected data at the end of the day, the data that was collected on one iPad will be available
for viewing on another iPad, even if the data was not collected on the second iPad.

This step requires a local wi-fi connection that will allow the iPads to communicate with each other, as in step 6b.

To merge the collected survey data (with the iPads connected to the local wireless network):

a. Select one iPad (TARGET iPad) that will receive all of the data from the other iPads.

b. Access HanDBase on one of iPads FROM which you will send the data to the TARGET iPad. This is the delivery iPad. Initiate the Desktop Connect mode by touching the Connect button at the bottom of the Databases window. (Alternatively, touch the monitor on the HanDBase splash screen.

c. On the TARGET iPad, open the Safari browser, and input the ip address that appears on the Desktop Connect Window on the DELIVERY iPad.

d. A screen similar to Figure 17 should appear on the TARGET iPad. Locate the land use database in the list of databases, and touch the appropriate icon (see Figure 17), to download the the database from the DELIVERY iPad to the TARGET iPad.

e. On the following screen, touch the "Open in HanDBase" button.

f. Repeat steps 11b- 11e for any other DELIVERY iPads to sent data to the SAME TARGET iPad that was chosen in step 11a.

At this point the data from all the other iPads should be merged onto the TARGET iPad's database. Email this merged database to the other iPads by following step 6a. Open this merged database on the other iPads to update their databases to include the merged data. Repeat this step at the end of every subsequent day of data collection to ensure that all iPads have the most up-to-date data and to safeguard against the possibility of survey teams collecting data more than once.

NOTE: If the DELIVERY iPad happens to have data for the same record/parcel as the TARGET iPad, the data for that record on the TARGET will be overwritten with the data from the DELIVERY iPad. Theoretically, this should only be a problem if the surveyors mistakenly survey the same parcel AND if they assess the parcel...
differently. The only real safeguards against this is to **ensure that the survey maps contain exclusive MAPIDs** (i.e., if two parcels appear on two or more separate maps, the MAPID only appears on one of the maps, since the parcel should only be assessed if the surveyor is able to verify that they are entering data for the correct parcel by referring to the MAPID), and to also **make sure that surveyors have a mutual understanding of how parcels are assessed in the field to ensure consistency with the survey process.**

### 12. Extracting Data from the iPads

After all of the data has been collected and merged into a single database, you can extract the database as a CSV file to import into Microsoft Access and ArcGIS.

To extract the database to a CSV onto a desktop PC where the analysis will take place:

- **a.** Initiate Connect mode on the iPad with the completed database.
- **b.** On the PC, open the internet browser and go to the ip address indicated on the iPad.
- **c.** Locate the land use database on the list of databases, and click the icon to download the database as a Comma Separated Values (CSV) file (Figure 18).
- **d.** Open the downloaded CSV file in Excel and verify that the data appears as expected.
- **e.** Save the CSV file as an Excel Workbook (.xlsx).
VI. Importing to ArcGIS and mapping

This section outlines the steps for importing the Excel file containing the land use data into Microsoft Access for further manipulation and analysis in ArcGIS.

13.1 Importing from CSV format to Access

a. Open Microsoft Access.

b. Open the land use geodatabase that was created and configured in steps 2 and 3.

c. On the toolbar, select External Data.

d. On the "Import" tab, select "Excel".

e. Browse your computer for the Excel Workbook that was saved in step 12.

f. Make sure that "Import the source data into a new table in the current database." is selected. Click OK.

g. On the Import Spreadsheet Window that appears, verify that the attributes columns appear as expected. Click Next.

h. The next window asks to specify information about each of the fields you are importing. You should not have to make any changes. Click Next.

i. The following window will ask you to define a primary key (unique identifier) for your new table. Select "Choose my own primary key.", and select the OBJECTID column if it is not already chosen. Click Next.

j. On the next window, Access allows you to specify a name for the table. Give it an appropriate name such as "Field data". Click Finish.

k. If you want, you can save the import steps for the future. To do so, highlight the checkbox. Click the Close button.

l. The Navigation Pane should display a row for the table you just imported into the geodatabase (Figure 19). Click on the table to open it and verify that the import as proceeded as expected.
13.2 Updating the Geodatabase with the imported data

Next, you will create a query in Access to update the land use feature class shapefile with the data in the imported spreadsheet.

- a. Click the "Create" option in the Toolbar.
- b. On the "Other" pane, click "Query Design".
- c. Two windows will appear. A Query Design window and a Show Table window. On the Show Table window, double click on the selections for your Land Use Database and your Field Data. This will make them appear in the Query Design Window. Close the Show Table window.
- d. Establish a link between the two tables by relating them with the unique identifier (OBJECTID). In the window for one of the tables, click and drag the OBJECTID field to the same field for the other table (Figure 20). A line should appear which shows that the two tables are now related to each other via the OBJECTID field.
- e. In the Design Pane at the top, select Update for the Query Type.
- f. In the window for the destination Land Use table, double click all of the attributes to be updated/receive the information from the data table. This will consist of all of the attributes columns that were created in step 3f, and specified in Appendix A. Notice that as you double click on each attribute, it will appear in lower half of the Design window (Figure 21). This portion of the window is displaying the exactly what type of information will be updated. Refer to Figure 22 as the following components are explained.

**Field:** Indicates the field that will be updated. In the example provided, the first four data columns listed (from left to right) are the address number (Add_Num), street (Add_Street), the specific primary land use (SpcPri_LU) and the specific secondary land use (SpcSec_LU). This field will automatically populate as you double click the attributes for the destination table.

**Table:** Indicates which table will be updated. The Field indicated in the above row is located in the table indicated in
this row. In the example listed the destination table is the attribute table for the Newark shapefile, named "Newark_Land_Use_Database". This field will also automatically populate as you double click the attributes for the destination table.

Update to: This is where you specify the source table and respective field for your data. The syntax is

[Table Name]![Field Name]

This field will not automatically populate, so the source must be manually specified. It can be typed in, or you can right click the field and select "Build" from the menu to access the Expression Builder, which will allow you to build the expression in the appropriate syntax. For now, notice that the field contains [Field Data]![Add_Num]. This expression contains everything we need to update our destination table, as it contains the name of the source table in brackets, and the name of the field within that source table, also in brackets. These two components are separated by an exclamation point.

Criteria: This is the criteria (if any) for the update process. You can use SQL queries to specify criteria for the update. For instance, if you only wanted to update data for where the destination table contained no values, you would use the above syntax to specify that the destination data for the field should be blank (or NULL) by typing [Table Name]![Field Name] = NULL. In the example here, we've indicated that the Add_Num field in the Newark_Land_Use_Database table should only be updated with the values in the Add_Num field from the Field Data table IF the OBJECTID in the Field Data table is equal to 4. Only the fourth record will be updated. In actual practice however, you will likely keep this field blank when you are updating the geodatabase for the first time. Notice that the street name data will be updated for the entire table (no criteria is specified in the second column).

See the Access help files for detail explanations on how to build queries and expressions.

g. After all of the attributes for updating have been specified, click the Run button at the top left corner of the screen. A message
should appear asking you to verify that number of rows that will be updated. Click OK.

h. Open the destination table from the Navigation Pane, and verify that the table has been updated with the values from the data spreadsheet. You can now open this geodatabase in ArcMAP, where all the values for the attribute table will appear populated with your data, and almost ready for further analysis.

14. Assigning Values to the General Land Use Fields

The final step in preparing the data involves the assignment of general land use categories based on the specific categories that were collected in the field. This can be accomplished in ArcMap.

a. Open ArcMap and create a new map document

b. Click the Add Data button and navigate to the Geodatabase that contains the Land Use feature class that was updated in step 13.2 (Figure 23). Add this feature class to ArcMap.

c. Open the attribute table for the Land Use Feature Class.

d. In the attribute table, click the Table Options button in the top left corner, and select Select By Attributes.

e. In the Select by Attributes window that appears, verify that "Create a new selection" is the chosen method.

f. In the list of attributes, locate and double click the column that contains the Specific Primary Land Use (SpcPri_LU if the attributes names in Appendix A were used)

g. The attribute name should appear in the query pane at the bottom. Click the equals (=) button.

h. Click the Get Unique Values button. This will cause all of the data values that are currently used in the Specific Primary Land Use column to appear.

i. Double click one of the specific primary land use values that corresponds to a General Land Use value of Residential. In Figure 24, "Apartment" is chosen.
j. Click the "Or" button.

k. Repeat steps 14.j - 14.j for build the query with all of the specific land use values that will correspond to residential. The query should read as follows:

\[ \text{SpcPri\_LU} = 'Apartment' \lor \text{SpcPri\_LU} = 'Multi Family (Duplex)' \lor \text{SpcPri\_LU} = 'Multi Family (Quad)' \lor \text{SpcPri\_LU} = 'Multi Family (Triplex)' \lor \text{SpcPri\_LU} = 'Single Family Attached' \lor \text{SpcPri\_LU} = 'Single Family Detached' \]

When applied this query will select all records/parcels that have a specific land use values that correspond to the general land use category of residential.

l. Click the Apply button. The Select by Attributes window should close, and the attribute table will appear with all the appropriate records selected.

m. Click the Show Selected Records button at the bottom of the attribute window to only view the previously selected records.

n. In the attribute window, locate the General Primary Land Use column (GenPri\_LU if using the schema from Appendix A).

o. Right click on the heading for the GenPri\_LU column and select Field Calculator.

p. In the Field Calculator window, input "Residential" (including the quotation marks) in the expression pane at the bottom (Figure 25).

q. Click OK.

r. Verify that the selected records have been updated with the General Primary Land Use value of Residential in the selected column.

s. Repeat steps 14.d - 14.r to populate the General Primary Land Use column with appropriate values after selecting corresponding specific values for Commercial, Mixed Use Public Facilities, and Open Space. The queries to select the records with corresponding Commercial, Mixed Use Public
Facility, and Open Space values are listed below for reference, and can be copied and pasted into the Select by Attributes window if you have used the same schema as provided in Appendix A.

Commercial:

\[
\text{[SpcPri LU]} = 'Retail' \text{ OR [SpcPri LU]} = 'Service' \text{ OR } \\
\text{[SpcPri LU]} = 'Office' \text{ OR [SpcPri LU]} = 'Industry'
\]

Mixed Use

\[
\text{[SpcPri LU]} = 'Residential/Commercial' \text{ OR } \\
\text{[SpcPri LU]} = 'CMU' \text{ OR [SpcPri LU]} = 'Public/Commercial'
\]

Public Facilities

\[
\text{[SpcPri LU]} = 'School' \text{ OR [SpcPri LU]} = 'Church' \text{ OR } \\
\text{[SpcPri LU]} = 'Police' \text{ OR [SpcPri LU]} = 'Fire' \text{ OR } \\
\text{[SpcPri LU]} = 'Waste' \text{ OR [SpcPri LU]} = 'Community Center' \text{ OR [SpcPri LU]} = 'Civic/Government' \text{ OR } \\
\text{[SpcPri LU]} = 'ROW'
\]

Open Space

\[
\text{[SpcPri LU]} = 'Park' \text{ OR [SpcPri LU]} = 'Agriculture/Natural Resource' \text{ OR [SpcPri LU]} = 'Conservation' \text{ OR [SpcPri LU]} = 'Streams/Drainage/Channels'
\]

1. Perform a search and select any records where the Specific Primary Land Use equals 'Vacant'. Run the Field Calculator to
update the General Primary Land Use column to 'Vacant' for these selected values.

u. Perform a search and select any records where the Specific Primary Land Use equals 'Other'. Run the Field Calculator to update the General Primary Land Use column to 'Other' for these selected values.

15. Representing Parcels in ArcMap

To represent the land use categories on the map, you can change the symbology for the Primary General Land Use values. This section outlines the simplest way to symbolize the parcels according to Primary Land Use values, but it may be necessary to deviate from the steps provided depending on how you choose to manage the data.

a. Double click the Land Use layer in the Table of Contents in ArcMap to display the layer properties.

b. Click the Symbology tab.

c. In the Show: pane on the left, select Unique Values.

d. For the Value Field:, select GenPri_LU. (General Primary Land Use).

e. Click the Add All Values button.

f. For each General Primary Land Use category, click the Symbol box, then select a color to represent the category.

g. If it is necessary to rearrange the order of the categories (for creating the legend, for example), you can highlight an individual category, then use the 'up' and 'down' arrows to the right to move the category up and down, relative to the other categories that you are including for symbolization.
VII. Final Considerations

This section outlines some final considerations for further use of the land use parcel data.

Quality Assurance/Control

Quality Assurance/Control should be viewed as an ongoing component of the land use data management process. Things to look for and correct when found include:

- Parcels with incorrect Specific and/or General land use values.
  
  Tip - Perhaps the best way to look for these is to symbolize (assign colors to land use values), then visually examine the parcels in the data view for any parcels values which may be erroneous. For instance, if looking at an area of the community that is mostly single family residential parcels, parcels that were given a possible incorrect value should stand out. If you locate a parcel which has a suspect value, use Google maps and Streetview to examine the parcel for the correct land use value.

- Residential parcels that have unreasonable high or low values for the number of dwelling units. Parcels with single family detached/attached dwellings should have one unit, although there may be cases where two attached units are located on one single parcel (In this case, the number of units for the parcel should be two, while the land use would be Residential > Single family attached.).

  Duplexes, Triplexes, Quadplexes, and Apartments should have two, three, four, and five or more units, respectively. However, there may be cases where these structures fall across two or more parcels. For instance, if a duplex is on two parcels with each parcel containing one dwelling unit from the duplex, then the land use for each parcel would be 'Multi Family Attached (Duplex)', and the number of dwelling units for each parcel should be 1. A similar method of tracking the number of dwelling units should be applied to Triplexes, Quadplexes, and Apartment structures that fall across multiple parcels. The corollary of this, of course, is to ensure that units are not being double counted. a
duplex spanning two parcels with one dwelling unit in each parcel
SHOULD NOT reflect two dwelling units in each of the two parcels.

- Rather than distributing the parcel database among team members, it
  may be preferable for one or two people to manage and maintain the
  parcel database, and to respond to data requests that other members of
  the studio team may have. This may help to ensure that data is consistent
  between elements, and that any data corrections to the land use database
do not need to occur across multiple datasets.

**Working with the data**

- It may be easier to export the Residential and Commercial Parcels as a
  separate Feature Classes once a certain level of quality control is
  reached. Doing so may make it easier to perform operations on the data
  or symbolize it on the map. For instance, you may wish to symbolize
  residential according to density classifications, while all other land use
  values and symbolized by their land use types.

**Generating new data**

- Computation of Total Acreages per Land Use: Use the Dissolve tool
  (Data Management Tools > Generalization >Dissolve) to easily generate
  total acreages for land use types. The Input Feature will be the Land Use
  feature class, and the Dissolve Field will be the General Primary Land
  Use field. This will combine all the parcels with the same general
  primary land use into a single feature. If you select the acreage column
  for the *statistics field* and 'Sum' for the *statistic type*, the tool will add the
  acreage of all of the dissolved parcels, per general land use type. This
  operation can also be performed for specific land use categories.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Attribute Label</th>
<th>Attribute definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add_Num</td>
<td>The numerical portion of the address of the parcel</td>
<td></td>
</tr>
<tr>
<td>Add_Street</td>
<td>The alphabetic portion of the address of the parcel</td>
<td></td>
</tr>
<tr>
<td>GenPri_LU</td>
<td>The General Primary Land Use type</td>
<td></td>
</tr>
<tr>
<td>GenSec_LU</td>
<td>The General Secondary Land Use type</td>
<td></td>
</tr>
<tr>
<td>GenTer_LU</td>
<td>The General Tertiary Land Use type</td>
<td></td>
</tr>
<tr>
<td>ST_Suffix</td>
<td>The suffix of the street on which the parcel is located.</td>
<td></td>
</tr>
<tr>
<td>SW_Con</td>
<td>The condition of the sidewalk</td>
<td></td>
</tr>
<tr>
<td>Parcel_Notes</td>
<td>Any important notes for the parcel</td>
<td></td>
</tr>
<tr>
<td>Notes_ST1</td>
<td>Notes for the first structure</td>
<td></td>
</tr>
<tr>
<td>Notes_ST2</td>
<td>Notes for the second structure</td>
<td></td>
</tr>
<tr>
<td>Notes_ST3</td>
<td>Notes for the third structure</td>
<td></td>
</tr>
<tr>
<td>BusName_ST1</td>
<td>Names of businesses in the first structure</td>
<td></td>
</tr>
<tr>
<td>BusName_ST2</td>
<td>Names of businesses in the second structure</td>
<td></td>
</tr>
<tr>
<td>BusName_ST3</td>
<td>Names of businesses in the third structure</td>
<td></td>
</tr>
<tr>
<td>Stories_ST1</td>
<td>Number of stories in the first structure</td>
<td></td>
</tr>
<tr>
<td>Stories_ST2</td>
<td>Number of stories in the second structure</td>
<td></td>
</tr>
<tr>
<td>Stories_ST3</td>
<td>Number of stories in the third structure</td>
<td></td>
</tr>
<tr>
<td>Units_ST1</td>
<td>Number of units in the first structure</td>
<td></td>
</tr>
<tr>
<td>Units_ST2</td>
<td>Number of units in the second structure</td>
<td></td>
</tr>
<tr>
<td>Units_ST3</td>
<td>Number of units in the third structure</td>
<td></td>
</tr>
<tr>
<td>VacUn_ST1</td>
<td>Number of vacant units in the first structure</td>
<td></td>
</tr>
<tr>
<td>VacUn_ST2</td>
<td>Number of vacant units in the second structure</td>
<td></td>
</tr>
<tr>
<td>VacUn_ST3</td>
<td>Number of vacant units in the third structure</td>
<td></td>
</tr>
<tr>
<td>Con_ST1</td>
<td>Condition of the first structure</td>
<td></td>
</tr>
<tr>
<td>Con_ST2</td>
<td>Condition of the second structure</td>
<td></td>
</tr>
<tr>
<td>Con_ST3</td>
<td>Condition of the third structure</td>
<td></td>
</tr>
<tr>
<td>ST_Acc_ST1</td>
<td>Street access for the first structure</td>
<td></td>
</tr>
<tr>
<td>ST_Acc_ST2</td>
<td>Street access for the second structure</td>
<td></td>
</tr>
<tr>
<td>ST_Acc_ST3</td>
<td>Street access for the third structure</td>
<td></td>
</tr>
<tr>
<td>SW_Acc_ST1</td>
<td>Sidewalk access for the first structure</td>
<td></td>
</tr>
<tr>
<td>SW_Acc_ST2</td>
<td>Sidewalk access for the second structure</td>
<td></td>
</tr>
<tr>
<td>SW_Acc_ST3</td>
<td>Sidewalk access for the third structure</td>
<td></td>
</tr>
<tr>
<td>Surveyed</td>
<td>Check box indicating if parcel was surveyed.</td>
<td></td>
</tr>
<tr>
<td>Cnvs_ST1</td>
<td>Presence of unit conversion in the first structure</td>
<td></td>
</tr>
<tr>
<td>Cnvs_ST2</td>
<td>Presence of unit conversion in the second structure</td>
<td></td>
</tr>
<tr>
<td>Cnvs_ST3</td>
<td>Presence of unit conversion in the third structure</td>
<td></td>
</tr>
<tr>
<td>SpcPri_LU</td>
<td>The Specific Primary Land Use type</td>
<td></td>
</tr>
<tr>
<td>SpcSec_LU</td>
<td>The Specific Secondary Land Use type</td>
<td></td>
</tr>
<tr>
<td>SpcTer_LU</td>
<td>The Specific Tertiary Land Use type</td>
<td></td>
</tr>
<tr>
<td>Cmns_ST1</td>
<td>Presence of unit conversion in the first structure</td>
<td></td>
</tr>
<tr>
<td>Cmns_ST2</td>
<td>Presence of unit conversion in the second structure</td>
<td></td>
</tr>
<tr>
<td>Cmns_ST3</td>
<td>Presence of unit conversion in the third structure</td>
<td></td>
</tr>
<tr>
<td>CMU</td>
<td>Residential/Commercial</td>
<td></td>
</tr>
<tr>
<td>Public</td>
<td>Commercial</td>
<td></td>
</tr>
<tr>
<td>Community</td>
<td>Open Space</td>
<td></td>
</tr>
<tr>
<td>Recreational</td>
<td>Commercial</td>
<td></td>
</tr>
<tr>
<td>Church</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Police</td>
<td>Commercial</td>
<td></td>
</tr>
<tr>
<td>Fire</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Waste</td>
<td>Commercial</td>
<td></td>
</tr>
<tr>
<td>Community Center</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Civic/Government</td>
<td>Commercial</td>
<td></td>
</tr>
<tr>
<td>ROW</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Park</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Agriculture</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Conservation</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Streams/Drainage/Channels</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Vacant</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>Residential</td>
<td></td>
</tr>
<tr>
<td>Con_ST1</td>
<td>Condition of the structure</td>
<td></td>
</tr>
<tr>
<td>Con_ST2</td>
<td>Condition of the structure</td>
<td></td>
</tr>
<tr>
<td>Con_ST3</td>
<td>Condition of the structure</td>
<td></td>
</tr>
<tr>
<td>ST_Acc_ST1</td>
<td>Street access for the first structure</td>
<td></td>
</tr>
<tr>
<td>ST_Acc_ST2</td>
<td>Street access for the second structure</td>
<td></td>
</tr>
<tr>
<td>ST_Acc_ST3</td>
<td>Street access for the third structure</td>
<td></td>
</tr>
<tr>
<td>SW_Acc_ST1</td>
<td>Sidewalk access for the first structure</td>
<td></td>
</tr>
<tr>
<td>SW_Acc_ST2</td>
<td>Sidewalk access for the second structure</td>
<td></td>
</tr>
<tr>
<td>SW_Acc_ST3</td>
<td>Sidewalk access for the third structure</td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**
- These fields will be given values after the survey has been completed.
### Table 1. Parcel Form Specification

<table>
<thead>
<tr>
<th>Control Number</th>
<th>Control Type</th>
<th>General</th>
<th>Layout</th>
<th>Attributes</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Data Source</td>
<td>Caption Source</td>
<td>Specify Caption</td>
<td>Left Origin</td>
</tr>
<tr>
<td>1</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Address/LandUse</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Structure 1 details</td>
<td>95</td>
</tr>
<tr>
<td>3</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Structure 2 details</td>
<td>225</td>
</tr>
<tr>
<td>4</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Structure 3 details</td>
<td>150</td>
</tr>
<tr>
<td>5</td>
<td>Label</td>
<td>OBJECTID</td>
<td>Other...</td>
<td>Map ID:</td>
<td>10</td>
</tr>
<tr>
<td>6</td>
<td>Text Box</td>
<td>OBJECTID</td>
<td>*</td>
<td>*</td>
<td>51</td>
</tr>
<tr>
<td>7</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>APN:</td>
<td>122</td>
</tr>
<tr>
<td>8</td>
<td>Text Box</td>
<td>APN</td>
<td>*</td>
<td>*</td>
<td>157</td>
</tr>
<tr>
<td>9</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Acreage:</td>
<td>185</td>
</tr>
<tr>
<td>10</td>
<td>Text Box</td>
<td>acres</td>
<td>*</td>
<td>*</td>
<td>105</td>
</tr>
<tr>
<td>11</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Street Address [number]:</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>Text Box</td>
<td>Add_num</td>
<td>*</td>
<td>*</td>
<td>71</td>
</tr>
<tr>
<td>13</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Street Name:</td>
<td>10</td>
</tr>
<tr>
<td>14</td>
<td>Text Box</td>
<td>Add_street</td>
<td>*</td>
<td>*</td>
<td>78</td>
</tr>
<tr>
<td>15</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Street Suffix:</td>
<td>10</td>
</tr>
<tr>
<td>16</td>
<td>Text Box</td>
<td>ST_Suffix</td>
<td>*</td>
<td>*</td>
<td>66</td>
</tr>
<tr>
<td>17</td>
<td>Popup</td>
<td>ST_Suffix</td>
<td>Field Name</td>
<td>*</td>
<td>125</td>
</tr>
<tr>
<td>18</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Survey Date:</td>
<td>10</td>
</tr>
<tr>
<td>19</td>
<td>Button</td>
<td>SurveyDate_date</td>
<td>Other...</td>
<td>Before Date:</td>
<td>70</td>
</tr>
<tr>
<td>20</td>
<td>Label</td>
<td>SurveyDate_date</td>
<td>Field Value:</td>
<td></td>
<td>134</td>
</tr>
<tr>
<td>21</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Parcel Notes:</td>
<td>132</td>
</tr>
<tr>
<td>22</td>
<td>Text Box</td>
<td>Parcel_notes</td>
<td>*</td>
<td>*</td>
<td>222</td>
</tr>
<tr>
<td>23</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Sidewalk condition:</td>
<td>232</td>
</tr>
<tr>
<td>24</td>
<td>Text Box</td>
<td>SW_Con</td>
<td>*</td>
<td>*</td>
<td>232</td>
</tr>
<tr>
<td>25</td>
<td>List Box</td>
<td>SW_Con</td>
<td>*</td>
<td>*</td>
<td>310</td>
</tr>
<tr>
<td>26</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Primary Land Use:</td>
<td>20</td>
</tr>
<tr>
<td>27</td>
<td>Text Box</td>
<td>SpcPri_LU</td>
<td>*</td>
<td>*</td>
<td>23</td>
</tr>
<tr>
<td>28</td>
<td>List Box</td>
<td>SpcPri_LU</td>
<td>*</td>
<td>*</td>
<td>23</td>
</tr>
<tr>
<td>29</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Secondary Land Use:</td>
<td>215</td>
</tr>
<tr>
<td>30</td>
<td>Text Box</td>
<td>SpcSec_LU</td>
<td>*</td>
<td>*</td>
<td>259</td>
</tr>
<tr>
<td>31</td>
<td>List Box</td>
<td>SpcSec_LU</td>
<td>*</td>
<td>*</td>
<td>259</td>
</tr>
<tr>
<td>32</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Tertiary Land Use:</td>
<td>200</td>
</tr>
<tr>
<td>33</td>
<td>Text Box</td>
<td>SpcTerc_LU</td>
<td>*</td>
<td>*</td>
<td>300</td>
</tr>
<tr>
<td>34</td>
<td>List Box</td>
<td>SpcTerc_LU</td>
<td>*</td>
<td>*</td>
<td>300</td>
</tr>
<tr>
<td>35</td>
<td>Check Box</td>
<td>Surveyed</td>
<td>Field Name</td>
<td>*</td>
<td>310</td>
</tr>
<tr>
<td>Control Number</td>
<td>Control Type</td>
<td>Data Source</td>
<td>Caption Source</td>
<td>Specify Caption</td>
<td>Left Origin</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
<td>-------------</td>
<td>----------------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1 Tab</td>
<td>No Field</td>
<td>Other.</td>
<td>Address/LandUse</td>
<td>0 0 95 22</td>
<td>Grey (200, 200, 200)</td>
</tr>
<tr>
<td>2 Tab</td>
<td>No Field</td>
<td>Other.</td>
<td>Structure 2 details</td>
<td>95 0 95 22</td>
<td>White (255, 255, 255)</td>
</tr>
<tr>
<td>4 Tab</td>
<td>No Field</td>
<td>Other.</td>
<td>Structure 2 details</td>
<td>285 0 95 22</td>
<td>Grey (200, 200, 200)</td>
</tr>
<tr>
<td>5 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Structure notes:</td>
<td>25 31 100 1</td>
<td>*</td>
</tr>
<tr>
<td>6 Text Box</td>
<td>Notes ST1</td>
<td>*</td>
<td>*</td>
<td>103 31 228 3</td>
<td>checked</td>
</tr>
<tr>
<td>7 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Number of Stories:</td>
<td>0 82 82 1 1</td>
<td>*</td>
</tr>
<tr>
<td>8 Text Box</td>
<td>Stories ST1</td>
<td>*</td>
<td>*</td>
<td>84 83 81 1 1</td>
<td>checked</td>
</tr>
<tr>
<td>9 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Number of Units:</td>
<td>177 83 140 1 1</td>
<td>*</td>
</tr>
<tr>
<td>10 Text Box</td>
<td>Units ST1</td>
<td>*</td>
<td>*</td>
<td>278 83 53 1</td>
<td>checked</td>
</tr>
<tr>
<td>11 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Number of Vacant Units:</td>
<td>177 89 82 2 *</td>
<td>*</td>
</tr>
<tr>
<td>12 Text Box</td>
<td>VacUn ST1</td>
<td>*</td>
<td>*</td>
<td>278 107 53 1 1</td>
<td>checked</td>
</tr>
<tr>
<td>13 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Business Name(s):</td>
<td>20 110 82 1 1</td>
<td>*</td>
</tr>
<tr>
<td>14 Text Box</td>
<td>BusName ST1</td>
<td>*</td>
<td>*</td>
<td>106 123 225 4 4</td>
<td>checked</td>
</tr>
<tr>
<td>15 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Condition of Building:</td>
<td>0 186 98 1 1</td>
<td>*</td>
</tr>
<tr>
<td>16 Text Box</td>
<td>Con ST1</td>
<td>*</td>
<td>*</td>
<td>98 186 60 1 1</td>
<td>not checked</td>
</tr>
<tr>
<td>17 List Box</td>
<td>Con ST1</td>
<td>*</td>
<td>*</td>
<td>0 201 83 6 1 1</td>
<td>checked</td>
</tr>
<tr>
<td>18 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Presence of Unit Conversion:</td>
<td>181 176 82 2 1</td>
<td>not checked</td>
</tr>
<tr>
<td>19 Text Box</td>
<td>Cnvs ST1</td>
<td>*</td>
<td>*</td>
<td>268 182 60 1 1</td>
<td>not checked</td>
</tr>
<tr>
<td>20 List Box</td>
<td>Cnvs ST1</td>
<td>*</td>
<td>*</td>
<td>182 201 77 6 1</td>
<td>checked</td>
</tr>
<tr>
<td>21 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Fixed Access to Street:</td>
<td>10 300 64 2 1</td>
<td>not checked</td>
</tr>
<tr>
<td>22 Text Box</td>
<td>ST_Acc ST1</td>
<td>*</td>
<td>*</td>
<td>98 303 60 1 1</td>
<td>not checked</td>
</tr>
<tr>
<td>23 List Box</td>
<td>ST_Acc ST1</td>
<td>*</td>
<td>*</td>
<td>0 332 83 6 1 1</td>
<td>checked</td>
</tr>
<tr>
<td>24 Label</td>
<td>No Field</td>
<td>Other.</td>
<td>Sidewalk Access:</td>
<td>185 304 71 1 1</td>
<td>not checked</td>
</tr>
<tr>
<td>25 Text Box</td>
<td>SW Acc ST1</td>
<td>*</td>
<td>*</td>
<td>269 303 60 1 1</td>
<td>not checked</td>
</tr>
<tr>
<td>26 List Box</td>
<td>SW Acc ST1</td>
<td>*</td>
<td>*</td>
<td>183 323 84 6 1</td>
<td>checked</td>
</tr>
</tbody>
</table>
### Table 3. Structure 2 Details Form Specification

<table>
<thead>
<tr>
<th>Control Number</th>
<th>Control Type</th>
<th>General</th>
<th>Layout</th>
<th>Attributes</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Data Source</td>
<td>Caption Source</td>
<td>Specify Caption</td>
<td>Left Origin</td>
<td>Top Origin</td>
</tr>
<tr>
<td>1</td>
<td>Tab</td>
<td>No Field</td>
<td>Other..</td>
<td>Address/LandUse</td>
<td>0 0 95 22</td>
</tr>
<tr>
<td>2</td>
<td>Tab</td>
<td>No Field</td>
<td>Other..</td>
<td>Structure 1 details</td>
<td>95 0 95 22</td>
</tr>
<tr>
<td>3</td>
<td>Tab</td>
<td>No Field</td>
<td>Other..</td>
<td>Structure 2 details</td>
<td>190 0 95 22</td>
</tr>
<tr>
<td>4</td>
<td>Tab</td>
<td>No Field</td>
<td>Other..</td>
<td>Structure 3 details</td>
<td>285 0 95 22</td>
</tr>
<tr>
<td>5</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Structure notes:</td>
<td>25 31 100 1</td>
</tr>
<tr>
<td>6</td>
<td>Text Box</td>
<td>Notes_ST2</td>
<td>* *</td>
<td>103 31 228 3</td>
<td>*</td>
</tr>
<tr>
<td>7</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Number of Stories:</td>
<td>9 62 82 1</td>
</tr>
<tr>
<td>8</td>
<td>Text Box</td>
<td>Stories_ST2</td>
<td>* *</td>
<td>84 63 81 1</td>
<td>*</td>
</tr>
<tr>
<td>9</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Number of Units:</td>
<td>137 83 180 1</td>
</tr>
<tr>
<td>10</td>
<td>Text Box</td>
<td>Units_ST2</td>
<td>* *</td>
<td>278 83 53 1</td>
<td>*</td>
</tr>
<tr>
<td>11</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Number of Vacant Units:</td>
<td>177 99 82 2</td>
</tr>
<tr>
<td>12</td>
<td>Text Box</td>
<td>VacUn_ST2</td>
<td>* *</td>
<td>278 107 53 1</td>
<td>*</td>
</tr>
<tr>
<td>13</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Business Name(s):</td>
<td>9 130 82 1</td>
</tr>
<tr>
<td>14</td>
<td>Text Box</td>
<td>BusName_ST2</td>
<td>* *</td>
<td>106 128 225 4</td>
<td>*</td>
</tr>
<tr>
<td>15</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Condition of Building:</td>
<td>9 186 90 1</td>
</tr>
<tr>
<td>16</td>
<td>Text Box</td>
<td>Con_ST2</td>
<td>* *</td>
<td>98 186 60 1</td>
<td>*</td>
</tr>
<tr>
<td>17</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Presence of Unit Conversion:</td>
<td>181 176 82 2</td>
</tr>
<tr>
<td>18</td>
<td>Text Box</td>
<td>Cnvs_ST2</td>
<td>* *</td>
<td>268 182 60 1</td>
<td>*</td>
</tr>
<tr>
<td>19</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Paved Access to Street:</td>
<td>181 201 77 6</td>
</tr>
<tr>
<td>20</td>
<td>Text Box</td>
<td>ST_Acc_ST2</td>
<td>* *</td>
<td>268 182 60 1</td>
<td>*</td>
</tr>
<tr>
<td>21</td>
<td>List Box</td>
<td>Cnvs_ST2</td>
<td>* *</td>
<td>181 201 77 6</td>
<td>*</td>
</tr>
<tr>
<td>22</td>
<td>Text Box</td>
<td>SW_Acc_ST2</td>
<td>* *</td>
<td>268 182 60 1</td>
<td>*</td>
</tr>
<tr>
<td>23</td>
<td>List Box</td>
<td>ST_Acc_ST2</td>
<td>* *</td>
<td>181 201 77 6</td>
<td>*</td>
</tr>
<tr>
<td>24</td>
<td>Label</td>
<td>No Field</td>
<td>Other..</td>
<td>Sidewalk Access:</td>
<td>185 304 71 1</td>
</tr>
<tr>
<td>25</td>
<td>Text Box</td>
<td>SW_Acc_ST2</td>
<td>* *</td>
<td>269 303 60 1</td>
<td>*</td>
</tr>
<tr>
<td>26</td>
<td>List Box</td>
<td>SW_Acc_ST2</td>
<td>* *</td>
<td>183 323 84 6</td>
<td>*</td>
</tr>
<tr>
<td>Control Number</td>
<td>Control Type</td>
<td>Data Source</td>
<td>Caption Source</td>
<td>General</td>
<td>Layout</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
<td>-------------</td>
<td>----------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>1</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Address/LandUse</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Structure 1 details</td>
<td>95</td>
</tr>
<tr>
<td>3</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Structure 2 details</td>
<td>190</td>
</tr>
<tr>
<td>4</td>
<td>Tab</td>
<td>No Field</td>
<td>Other...</td>
<td>Structure 3 details</td>
<td>285</td>
</tr>
<tr>
<td>5</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Structure notes:</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>Text Box</td>
<td>Notes_ST3</td>
<td>*</td>
<td>*</td>
<td>103</td>
</tr>
<tr>
<td>7</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Number of Stories:</td>
<td>9</td>
</tr>
<tr>
<td>8</td>
<td>Text Box</td>
<td>Stories_ST3</td>
<td>*</td>
<td>*</td>
<td>84</td>
</tr>
<tr>
<td>9</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Number of Units:</td>
<td>17</td>
</tr>
<tr>
<td>10</td>
<td>Text Box</td>
<td>Units_ST3</td>
<td>*</td>
<td>*</td>
<td>278</td>
</tr>
<tr>
<td>11</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Number of Vacant Units:</td>
<td>177</td>
</tr>
<tr>
<td>12</td>
<td>Text Box</td>
<td>VacIn_ST3</td>
<td>*</td>
<td>*</td>
<td>179</td>
</tr>
<tr>
<td>13</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Business Name(s):</td>
<td>9</td>
</tr>
<tr>
<td>14</td>
<td>Text Box</td>
<td>BusName_ST3</td>
<td>*</td>
<td>*</td>
<td>106</td>
</tr>
<tr>
<td>15</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Condition of Building:</td>
<td>9</td>
</tr>
<tr>
<td>16</td>
<td>Text Box</td>
<td>Con_ST3</td>
<td>*</td>
<td>*</td>
<td>98</td>
</tr>
<tr>
<td>17</td>
<td>List Box</td>
<td>Con_ST3</td>
<td>*</td>
<td>*</td>
<td>9</td>
</tr>
<tr>
<td>18</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Presence of Unit Conversion:</td>
<td>171</td>
</tr>
<tr>
<td>19</td>
<td>Text Box</td>
<td>Cnvx_ST3</td>
<td>*</td>
<td>*</td>
<td>268</td>
</tr>
<tr>
<td>20</td>
<td>List Box</td>
<td>Cnvx_ST3</td>
<td>*</td>
<td>*</td>
<td>181</td>
</tr>
<tr>
<td>21</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Paved Access to Street:</td>
<td>102</td>
</tr>
<tr>
<td>22</td>
<td>Text Box</td>
<td>ST_Acc_ST3</td>
<td>*</td>
<td>*</td>
<td>98</td>
</tr>
<tr>
<td>23</td>
<td>List Box</td>
<td>ST_Acc_ST3</td>
<td>*</td>
<td>*</td>
<td>9</td>
</tr>
<tr>
<td>24</td>
<td>Label</td>
<td>No Field</td>
<td>Other...</td>
<td>Sidewalk Access:</td>
<td>185</td>
</tr>
<tr>
<td>25</td>
<td>Text Box</td>
<td>SW_Acc_ST3</td>
<td>*</td>
<td>*</td>
<td>269</td>
</tr>
<tr>
<td>26</td>
<td>List Box</td>
<td>SW_Acc_ST3</td>
<td>*</td>
<td>*</td>
<td>183</td>
</tr>
</tbody>
</table>

**Table 4. Structure 3 Details Form Specification**
Appendix C - Survey Map Creation

This Appendix outlines the process for creating the survey maps that will be used in the field.

1. Create an Grid Index for the Survey Maps
   
a. Load the **Survey Maps** ArcMap 10 document.

   b. Access **Page and Print Setup** from the **File** menu and verify that 11 X 17 is selects for the Paper and Page settings. Click **OK** to close the window after changing these settings if necessary.

   c. Add the shapefile/feature class that contains all the parcels that will be surveyed.

   d. Access Arctoolbox and select **Cartography Tools > Data Driven Pages > Grid Index Features**

   e. In the **Grid Index Features** tool window that appears:
      
      i. Under **Output Feature Class**, specify a location and name of the output index grid that the tool will generate.

      ii. Select the parcel shapefile for the **Input Feature**.

      iii. Check the **Generate Poly Grid that intersects input feature layers or datasets**, and **Use Page Unit and Scale** boxes.

      iv. In the **Map Scale** box, input "1".

      v. Select .35 miles for **Polygon Width**

      vi. Select .2 miles for **Polygon Height**

      vii. Values for **Polygon Grid Origin Coordinates**, **Number of Rows**, and **Number of Columns** should automatically generate based on the values selected above.
f. Click OK.

g. Click the symbol for the Index Grid in the Table of Contents to access the Symbol Selector window for the Index Grid. Change the Fill Color to No Color, the outline color to red, and the Outline Width to 2 pts.

2. **Setup Data Driven pages using the Index Layer**

   a. Click File > Page and Print Setup.

   b. Click the Data Driven Pages button.

   c. In the Setup Data Driven Pages window, under the Definition tab, check the Enable Data Driven Pages box.

   d. Verify that selected layer is Index Grid created in the step 1.

   e. For the Name Field and Sort Field entries, select PageName.

   f. Check the Sort Ascending box.

   g. Click the Extent tab.

   h. In the Size field under Margin, input 105 and select ‘Percentage’ from the drop down list.

   i. Click OK to close the Setup Data Driven Pages window, then click OK to close the Page and Print Setup Window.

   j. Click the arrow on the Add Data button, then select Add Basemap.

   k. Select the **Bing Maps Hybrid** basemap, and click the Add button.

   l. Access the layer properties for the parcel shapefile.
m. Click the **Labels** tab.

n. Check the box for **Label features in this layer**.

o. In the **Text String** section of the **Labels** tab, select the unique identifier that was created in Section IV, step 2.e.

p. Under the **Text Symbol** section, select an 11 point font size. This may need to be changed to a smaller text size, depending on the results of step 2.bb. toward the end of this section.

q. Click the **Symbol** button, then the **Edit Symbol** button, then the **Mask** tab.

r. Select **Halo**.

s. Click the **OK** button as necessary to return to the **Labels** tab in the **Layer Properties** window.

t. Click the **Placement Properties** button

u. Under the **Polygon Settings** section, select **Try horizontal, then straight**.

v. Check the box next to **Only place label inside polygon**. This may need to be changed for individual maps depending on the results of step 2.bb. toward the end of this section.

w. Click **OK** to close the **Placement Properties** window.

x. Click **OK** to close the **Layer Properties** window.

y. Click the symbol for the parcel shapefile in the **Table of Contents** to access the **Symbol Selector** window for the parcel shapefile. Change the **Fill Color** to **No topaz Sand**, the outline color to black, and the Outline Width to 1 point.

z. Turn on the Bing Maps Hybrid layer if it is not active in the **Table of Contents**.

aa. Click **File > Print Preview**.
bb. Use the Print Preview to check that the parcels for the maps correctly display parcels and unique identifiers labels correctly. Cycle through individual pages by clicking the First, Last, Next and Previous buttons as needed. Depending on the results of individual map pages, it may be necessary to go back and print particular map pages after adjusting the text display properties (labels only placed inside polygons, font size) so that labels appear correctly inside relatively small and/or compacted parcels.

c. After the map pages have been verified for display integrity, click the Print button.

dd. In the Print window, under Data Driven Pages, make sure that 'All' is selected, then click the OK button to print the map files.
Appendix D – Importing new parcel attributes into an Existing Database

This appendix outlines the process for importing a new parcel geodatabase into an existing HanDBase database. This will allow the survey designer to save time if an existing HanDBase database is available and if the schema for the existing database will be used for the current data collection effort.

a. Create a new personal geodatabase and import the parcel shapefile as per Step 2 in Section 4.

b. Open HanDBase Data Exchange for Microsoft Access and select “Convert Access to HanDBase Database”.

c. Under “Enter an MS Access (.mdb) database to import from” select the geodatabase created in step a. above.

d. Select the table within that database which contains the parcel attribute information (This should have the same name as the parcel shapefile that was imported into the geodatabase in step 2 in Section 4).

e. Under “Enter a destination HanDBase database:” select the already existing and configured HanDBase database that will receive the new parcel records.

f. Select “Delete any existing HanDBase records”. Do not select “Delete and Replace HanDBase database, as doing so will remove special settings and field options of the target HanDBase database.

g. The final selection at the bottom of screen asks you to specify whether you wish to import all columns, selected columns, or mapped columns. Unless you have configured column attribute headings in the parcel shapefile to exactly match those of the the target database, the “Import all Columns” and “Import Selected Columns” selections will return an error indicate a schema mismatch. If these errors occur, then
select “Import Mapped Columns”, then click the Map Columns button.

**h.** In the *Map Access Columns to HanDBase Columns* window, highlight the existing column within the parcel shapefile (“From Columns:” window) that should be imported into the destination HanDBase database. Then select the corresponding target column in the destination database. For example, the parcel shapefile should already have acreage calculations, but this information should be transferred to the destination database. In this case, the user would select the acreage column within the From Columns window, then select the corresponding acreage column in the To Columns: window. With these columns highlighted, click the “Map Columns” button to establish the relationship between the attributes. Now, when the Access database is imported into the HandDBase database, the acreage information will carry over into the appropriately named column. Repeat this process for other existing column that should transfer new data into the existing database, such as the APN and unique identifier columns.

**i.** If you are following the procedures in this Appendix as instructed from the note in Section IV, Step 3, the parcel shapefile that you are importing will not have additional attributes to map beyond the acreage, unique identifier, and APN columns. If this is the case, click the OK button to close the mapping columns window. Otherwise, map the other columns that you wish to import and then click the OK button.

**j.** Click the Import button to complete the Importation process.

**k.** Open the destination HanDBase database in HanDBase Desktop and examine to verify that the records have imported correctly by comparing the number of records in the HanDBase database with the number of records in the original parcel shapefile.
l. Also, left click the headers for the attributes with predefined values, and select Field Properties.

m. Click the Edit Popups button to verify that the predefined attribute values from the old HanDBase database appear as expected for the appropriate column. Perform any adjustments that are needed as outlined in Section 4, Step 5, using Appendix A of this guide as a reference.

n. After you have verified that the new parcel data was successfully imported in the older database and that desired attribute values are correctly configured for the appropriate columns, proceed with Step 6 in Section 4.
Appendix E – Importing data entry forms from an older land use database into a new land use database.

On the iPad containing both the old land use database with the desired forms, and the newly imported land use database without forms:

a. Access the old land use database.

b. Touch the “Tools” icon in the lower right hand corner.

c. Touch “Database Properties”.

d. Select “Forms”.

e. Select the Address and Land Use Form.

f. Select “Copy”.

g. HanDBase will ask whether you wish to make a copy of the form in the current database or another database. Select “Other Database”.

h. Locate and select the new land use database which will import the desired form.

i. Repeat the process for the structure details forms.

Note that while the layout of the forms will carry over into the new database without an issue, the functionality/actions may not carry over successfully for all the form elements. Verify and/or correct the functionality of the form elements by following Step 9.e in Section IV and using Appendix B as a guide for configuring the form elements.